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INTRODUCTION

The objective of this Document is to assist qualified persons (QPs) in developing BIM models to meet new
requirements of Building Information Model (BIM) submission. It describes the features available inside the
Architectural BIM e-Submission Template and the step-by-step guide to apply them into the project. The BIM
Submission Template creates a basic structure to assist the QPs in preparing the BIM models for regulatory
approval according to the Architectural BIM e-Submission Guideline. It is by no means an exhaustive

template and QPs are allowed to edit/change accordingly to suit their needs.

For any additional requirements that require customisations to a certain extent, QPs are also advised to
make reference to the training materials distributed or to consult the respective software vendor for any
enquiries on the application. If there are contradictions between this submission guideline and vendor’'s
instructions, BCA BIM team shall be contacted for clarification. Please note that any BIM Submission

Guideline and its Template shall be collected from the BCA BIM team.

This training material is meant for GRAPHISOFT ArchiCAD Users reference only. Diagram below

summarises the important features available in the submission template.

asca
= [ Floor Plans
[ BCA-_FP_ROOF
[ BCA-_FP_ 10th STOREY
[ 8CA-_FP_ 9th STOREY
[ BCA-_FP_8th STOREY . d -
3 BCA-_FP_ 7th STOREY | 5 [ oS o

’ = 4 3 A [ BCA-_FP_ 6th STOREY =
All Model Views in One [ BCA-_FP_. Sth STOREY ~“Rules Added on CP83 Colours
Single File —Lpgidida for A&A and Re-submission —
4 = [ BCA-_FP_ 2nd STOREY = SUTLINS

[ BCA-_FP_ 15t STOREY
5[] Sections
Submissions Grouped o

by Agency ; of the Building Control Act (Cap 29), that -

(a) the preparation of these building plans are in accordance
Regulations; and

Standard Naming (b) the buildings/ building works shown on these plans are in accor
the provisions of the Building Control Regulations and the

Convention g Aoproved Document

. 6
) “Insertion of Endorsement/Declaration
Auto-populated GFA Statement becomes like form filing

Summary Table for
Submission

]

= | % 1,' Communication
N TS c* 2 **°*¢ Regulatory
Professionals Officers

—_— —
Copyright © 2015 Building and Construction Authority. All Rights Reserved. 4
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PART I. Getting Started

. In the Start ArchiCAD dialog box, under
section “What would you like to do?” select
“Create a New Project.”

. Tick “Use a Template,” and select

SG_BIM e-Submission Template_v18.tpl
or;

In the file directory dialog, select Browse
Template... then navigate to the folder
where the BIM submission template file
(.tpl) resides.

. Choose “Standard Profile 18” as Work

Environment.

.Select the template and click New.

Note: To ensure originality, please make
sure that you get the BIM Submission
Guideline & template from CORENET

BIM support team

GRAPHISOFT.
ARCHICAD 18

® Start ArchiCAD 18

What would you like to do?
D O Create a New Project .
‘fi Open a Project

Set up Project Settings

°Usa a Template
BIMSubmissionTemplate_Mar2015({ArchiCAD18).tpl

_ Use Latest Project Settings

Set up Work Environment
E Use: &P Standard Profile 18
Quit ArchiCAD New

Do not Display this Dialog Next Time

Copyright © 2015 Building and Construction Authority. All Rights Reserved.
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.Once the template is opened, click the

Layout Book <
the right.

at Navigator palette on

.Expand the Masters tab; double click the
master layout of BCA-BP with Acceptable

Solutions to open.

.When the master layout is opened in the
drawing area for editing, you may navigate
to the titleblock on the right of the
sheet/layout (as highlighted in RED) to
customise it according to your company’s

standard, including your company’s logo.

Note: Please try not to change other parts of
the sheet/layout (including the top

corner of the titleblock), as this will
mess up the automated feature

available within the template
A\ /4

. Repeat Steps 7-8 for customising the

URA, FSSD and other

technical departments.

titleblocks for

Note: This is a one-time setting ONLY so
that you could apply this in all your

future projects.

.Once done, click File menu »

Save (Ctrl+S) to replace the existing
SG_BIM e-Submission
template file.

Template_v18

>

=@

Tree by subset

»

v G#Insert Project Name
[2A.01 URA-_LV_ARCHITECT'S DECLARATION
[gA.02 BCA-_LV_ARCHITECT'S DECLARATION
[2A.03 FSSD-_LV_ARCHITECT'S DECLARATION
[2A.04 CBPD-_LV_ARCHITECT'S DECLARATION

v

i Masters
B8 BCA-BP with Acceptable Solutions
I8 BCA-BP with Alt Sols_Sole
I8 BCA-BP with Alt Sols_Joint
I8 BCA-A8A
B8 BCA-ST with Acceptable Sols
I8 BCA-ST with Alt Sols
BB BCA-CD_QP
B2 URA- Owner Consent, DIP & RLP
B8 URA-Subdivision Appin
B8 URA-Strata Subdivision Apptn
B8 URA-Conservation_Architect
B8 URA-Conservation_Engineer
B8 FSSD-FSW w Prstv Prvsn FC_BP
B8 FSSD-FSW w Prstv Prvsn FC_FP&AC
B8 FSSD-FSW w Alt Sols_BP_Option1
B8 FSSD-FSW w Alt Sols_BP_Option2
B8 FSSD-FSW w Alt Sols_FP_Option1
B8 FSSD-FSW w Alt Sols_FP_Option2
[BE FSSD-A&A
I8 CBPD/PUB-DIP
B8 Other Technical Departments

Copyright © 2015 Building and Construction Authority. All Rights Reserved.
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[ ) New Project

Create a N0 ChICAD 18 Tomplate.tp!

.Now that you have updated your own BIM || g b me

v BIMSubmissionTemplate_Mar2015(ArchiCAD18).pl

) ) . Uul.; :gn&:btemplat.um.tpl _ 7 o
Submission template, every time you | o g o
create a new project (File » New), select Launch a new instance of AhICAD
the BIM submission template you saved, s S v

Use: Current Profile
and click New. Gancel

PART Il: ArchiCAD Navigator

.The first thing you see is the navigator palette ’| | fr | = | = | Oy
on the right, which should contain a structure V iy #Insert Project Name
o = . b JALL
organisation by folder for BIM submission. AL
> _JBCA
The images on the next page (highlighted in » [JURA
RED) shows View Map Environment and » IFSSD
Layout Book: Sheets prepared for > aPuB
i > _JCBPD
publishing. > LajIndexes
&-[8cA
(&[] Floor Plans
Sections
(3 [5] Elevations
?ﬂ:boocunems
-6 BCA-_3D_ Generic Perspective
- @ BCA-_3D_Frontal Axonometry
.[@] Interior Elevations
[ Detais

BCA-_LV_SUMMARY OF STATISTICAL GROSS FLOOR AREA (SGFA)
BCA-_LV_ SUMMARY OF OTHER AREAS NOT INCLUDED IN GFA COMPUTATION

Note: The BIM submission template -
creates a basic platform that could

-QWRA

i 0 Floor Plans
help you in preparing your mgdel for o
regulatory approval. It is not - [E] Blevations

: -3 30 Documents

mandatory and you are free to edit -G URA-_3D_Generic Perspective
according to your needs, as long as ;{gm”a;v','“m“m“’“'
the final results presented to the j i petals

authorities meet the requirements as
specified in the BIM e-Submission
Guideline.

URA-_LV_ SUMMARY OF GROSS FLOOR AREA (GFA)_ver2

URA-_LV_SUMMARY OF GROSS FLOOR AREA (GFA)_ver1
URA-_LV_ SUMMARY OF GROSS FLOOR AREA (E-GFA) Sample

Copyright © 2015 Building and Construction Authority. All Rights Reserved.
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View Map: Layout Book:
Submission Environment Sheets
SRR (@ Havgator-LoyoutBook |
o(EE o [+ T I
=R #Insert Project Name
A Tree by subsat .
il - EAHUDI' Plans T finsert Project Name
[2 BCA-_FP_ROOF O A0 URA-_LV_ARCHITECTS DECLARATION
[ BCA-_FP_ 10th STOREY 7]
g BCA- FP_ 9th STOREY = Ol 02 BCA-_LV_ARCHITECT'S DECLARATION
[ BCA-_FP_ 8th STOREY s |Gl A.03 FESD-_L¥Y_ARCHITECT'S DECLARATION
[P BCA-_FP_ 7th STOREY o .
oS R & a4 CAPD-_LV_ARCHITECT'S DECLARATION
[ BCA-_FP_ Sth STOREY 8 ¥ | g Wasion
[ BCA-_FP_ 4th STOREY - Bl s
[ BCA-_FP_ 3rd STOREY L ERECA-BF whts Accaplable
[ BCA-_FP__ 2nd STOREY  BCA-BP with All Sols_Sola
[ BCA-_FP_ 1st STOREY -mﬂp it Alt Sols_Joint
—-[@] Sections
; BCA-_FX_SECTIONS1 Sections Wl eca-ans
{1 BCA-_FX_SECTION 52 Bl BCA-5T with Accepiabla Sois
- : Flevanons
(5] BCA-_FE_ELEVATIONE1 I BCA-ST with At Sols
{5} BCA-_FE_ELEVATION E2 Elev at ions -m.m 0]
{7 BCA-_FE_ELEVATION E3 B
& BCA-_FE_FLEVATION E4 I URA- Cranar Consani, DIF & ALP
+)-[77] 3D Documents I VR Bubdivision Appin
-l..“l.lEtl'..l Bubdivision Appin
[ vRi-Corsersabon_Architect
[ WRA-Corsarsabon_Enginees
B FSSD-F5W w Praty Prven FC_EP

PART Ill: Project Elevation/ Reference Level

.Click Design menu » Story Settings. (CTRL+7 or d87)

.By default, the template provides 10 storeys for a project and a consistent floor-to-floor height as
4m for all the 10-storeys. You may need to edit according to your project requirements.

n Story Settings M

No. Name Elevation Height to Next > v

. 10 ROOF 40000 4000 -
. 9 10th STOREY 38000 4000
. 8 Sth STOREY 32000 4000
. 7 8th STOREY 28000 4000
. 8 7th STOREY 24000 4000
. & 8th STOREY 20000 4000
. 4 5th STOREY 18000 4000
. 3 4th STOREY 12000 4000
. 2 3:d STOREY 8000 4000
. 1 2nd STOREY 4000 4000

[ Insert Above ] [ Insert Below ] [ Delete Story ]

o ]

Copyright © 2015 Building and Construction Authority. All Rights Reserved. 8
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Note: This is a one-time setting ONLY that
you should do it before starting your

project modelling.

_/

. . - 'Dg
.To change project reference levels, click Bl FocgecrPesdere =
Reference Levels - << Previous [ Next >> }

Reference Levels Elevation Relative to

Reference Levels... e . -
I AmsL ]
Sea Level 9 L
[ ml J-100000] _

Note: Reference Levels are display and input aids. Actual Elevation values of model
elements are always calculated from Project Zero. Altitude can be set in the Project

.At the bottom section of Project References poemtensiea e

dialog, select the “Sea Level”, then type

Options menu » Project Preferences »

the project datum value you need in the
Elevation field. And click OK.

3rd STOREY a000
8,000 |
|
|
I
|
2nd STOREY 4000
4,000 i
|
|
I
|

Copyright © 2015 Building and Construction Authority. All Rights Reserved.
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Navigator - Project Map
. ==
Double click to open Elevation view E1 [l
..[Bg 10. ROOF
from the Project Map of the Navigator iy pitileing

B 7. 8th STOREY

palette, then use the Arrow tool to select 6. 7th STOREY
[Bx 5. 6th STOREY

. B 4. 5th STOREY

the Elevation marker. [ 3. 4th STOREY

[ 2. 3rd STOREY
[Bm 1. 2nd STOREY
[Pz 0. 1st STOREY
=[] Sections

. £ S1 (Auto-rebuild Model)
£ 52 (Auto-rebuild Model)
Under the Info box, click to open the

Settings dialog of Elevation marker.

§
Worksheets
Details

(=[] 3D Documents

Z31 QTTE DI AN A1 sén_rahild Madai

12 . . . . (' JiJ Dimension Selection Settin [ 2 [
.In the Dimension Selection Settings e sl

. Seteced 1
dialog, select “Sea Level” under the -
- [A' Type and Font
Dimension Origin, and click OK. Dimension Type: Marker Type: &
: b4t o—bi—b ++ @ ¥
o B 4@
SeaLevel > Static Dimension
Project Zero u J ’ @
[ e — =3 ).
. LN o - Western -
Repeat Steps 17-19 for the remaining I — 3w
Elevation Views E2, E3 and E4 (or other B Eled oA
elevation views you may have). v
|
W7LT%'%7¢JQQ W= ﬂ‘gg:%vo ¢ WC.M: S
|
hds.’iﬁ —é—“m L e I > mnsm:;: ¢ ﬂnoooE =
§
msronEvo_é‘ 0000 | unme_\; |oo.ooo: it

Copyright © 2015 Building and Construction Authority. All Rights Reserved. 10
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PART IV.a: Site Configuration

. To import the topographic map (.dwg)

given by your land surveyor, click File

menu » External Content » Attach Xref.

_4

.Click on the origin point of your ArchiCAD

1* floor plan to place the topo map. After

A

the CAD topo map is imported, click Fit in

Window (] at the bottom.

.Select all the elevation and section markers
on the floor plan/elevation and click Drag to
move them to the location of your new
topography map. Similarly, you need to
drag to move the markers and boundary
lines on the elevation and sectional views

to the new location.

Tl Attach Xref 2 [
1
Xref Name: <New XREF> v[ [ Browse... ]
Path:
Reference Type
© Attachment © overlay
Insertion Point Scale Rotation
Specify On-Screen Specify On-Screen Specify On-Screen
X: 0.00 | 1000.00 Angle: 0.00°
¥: 0.00 | 1000.00
() Drawing's own anchor point
() Bounding box node: Tre
RS
Place on story: 0. 1st STOREY -
Translator: 02 For editable import - Settings...
Description: Use this translator to open DXF/DWG content to continue editing them after »
conversion in ArchiCAD.

O,

N 41

384.05
E 36376.12

I3

Copyright © 2015 Building and Construction Authority. All Rights Reserved.
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v P [
. @uyms
Click Document menu » Layers » Layer | = % weeee v | T (shonallny
. . o & lsnd su:Od\L_ANO;TBLK_E
Settings (Model Views). In the Layer =< lnd s 041LE_BLOGFCLT_E0_A LINHAY
o < land su_0d|LE_BLDGPROF_TO_A_
. . o & land su_0d|LE_BRDG—_EQ_A_OVERHEAD
Settings dialog, turn on only the layers to =< ldde oo
. . . B @ land su_0d|LE_ROADKERB_E0_A_
which you want to apply elevation points |=< 2 0LE_TOPODRAN.E0.A_
(the CAD layer with points/contours given 7= e
. o & land su_Od|LE_TOPOSERV_EO_A_ _w
by your land surveyor), and click OK. = oy |
04 i e rorcaom gt i M
[ ([ ]
f‘: o :nasu:od\LE:TﬁvsuNE_;o_;: =
e e Vo L=
o land su_0d|SERVICES L
o land su_0d|TEXT - m

.To create the 3D terrain, double click the F@ &) | <, -, G ®

Mesh tool under the Toolbox, and draw the

boundaries. After the boundaries are set in

the plan, set the height (spot elevations) of

each node along the edge of the mesh. AR A h
; 106,65 v 106.87 10+7.(
J 2 LS
| 0
( %,
( %

.Select the mesh object you just created with
the Arrow Tool under Toolbox and then

click on the Mesh tool to make sure it is " ’ -
ﬂ New Mesh Points M

active. Click the Magic Wand Tool in the
Control Box palette. Ak hen Fona
Create Hole
”Fit to User Ridges -
o ]
e

Copyright © 2015 Building and Construction Authority. All Rights Reserved. 12
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.If the CAD topo map you have are

spots/points, manually insert the points of
terrain with the Magic Wand Tool by
clicking on one of the survey points after
you see the Mercedes cursor. With the
Mesh tool still active, press Spacebar +
click on each survey point and ArchiCAD
will auto-insert a point to the 3D terrain.
Each time, a “New Mesh Points” dialog box

will come up and make sure the “Fit to

A

User Ridges” option is chosen. Continue
Spacebar + clicking on all necessary
survey points until finished. (You only have
to pick the critical points to create the 3D

terrain)

dx: 36357777 l @ Ar: 55084857 ‘ X 42: 100000
Ay: 41381801 a 43.70° » to Sea Level O]

.With the 3D Terrain still selected and the

Mesh Tool active, click and hold the mouse A 6 79

button down on any node/contour lines and

+l

a Pet Palette will appear with options to

move the node or give it a Z elevation.

Choose the Z elevation option.

.When the “Mesh Point Height” dialog box

appears, insert the height accordingly,

based on the value as given by your land
surveyor. Select the reference as “to Sea
Level” (Ensure that you have inserted the
Sea Level in step 15 above). And click OK.

.Repeat Step 28 for the other nodes/ contour

lines of the 3D terrain.

Copyright © 2015 Building and Construction Authority. All Rights Reserved. 13
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PART IV.b: Importing Surveyors Data...

—

| Eﬂg' n Egument Options  Teamwork
Design Tools L
T %‘% QOutline Polygon with Magic Wand
E EE Story Settings... Ctrl+7
= - Edit Story Lewvels I
Complex Profiles 3|
B Update Zones,,
Align 3D Texture » (
E2 Connect L)

[5 Solid Element Operations...

@8 Convert Selection to Morph(s)

Medify Morph L
Modify Curtain Wall |
| Place Mesh from Surveyors Data...
TX Grid System ... i
\ Roof Extras L
. T4 Place Mesh from Surveyors Data (2 |3
. e dl
Go to Design » Place Mesh from Surveyors | || Surveyors Unit: meter M
Data... Placement: 2
© Define graphically
(© Original location

["] Zoom to the new mesh

. . Ii‘rojetheroisaboveSx‘zaLe\teIb]r:3
Choose a Surveyor Data file to open. A 0.00 ———
window dialogue will pop to be configured
accordingly then click OK. Concd | [ ox |
File name: The CC Place Tanjeng Pagar -
Save as type: [Tai Documents ("t} ']

~ Hide Folders Encoding,

7 ncode
Unicode big endian
UTF-8

|
Copyright © 2015 Building and Construction Authority. All Rights Reserved. 14
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PART V: Building Orientation to the True North

ildi H . arallel Projection ings m
.TO change the building orientation to the | e friscionsetins

true north on site plan, click View menu »
3D View Mode »3D Projection Settings. In

the Parallel Projection Settings dialog, click S
More Sun button at the bottom. Ry,
.’(‘):. Sun Azimuth
/u’ 240.00°
. SunAltitude
.Q:‘E. 35.00°
. NSun m
I T H Light Parameters
In the Sun dialog, set the city as Singapore i gt
and change the Project North to the true e — — .
¥ K = = ow v
orientation of your building project. Then ;ﬁ:’g’b : g » §
click OK. s = [¥] Auto Preview
Location and Date

SetCity... | Bingapore
1l o F o Elwo [Efme

+1hr Daylight Savings

Sun Azimuth: 18.94° m Project North: F5—05° @
Sun Altitude: k8.20° ik Note: Open Project Preferences 47

to change Project North.

Note: Though it's called 'Project' north, it's

true north, in that it's the only north,

and the north used by the sun

settings. Archicad doesn't directly
support a project north environment
variable separate from true north.

|
Copyright © 2015 Building and Construction Authority. All Rights Reserved. 15
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PART VI: GFA and SGFA Tabulation

For (URA) GFA Tabulation: b P E:

Default Settings
.Double click to open the floor plan from the

navigator palette. {@ T

Hame: <zone name>

MNo.: <room numbers=

lGFh Medical Instituti... [ ']

e Top:  1.2ND STOREY (Ho... (¥
.From the Toolbox select[ Zone tool. Home: 0. 15T STOREY (Curr... (7]

In the Info Box of Zone, assign the layer “L- % .
¥ b: O
_AREAGFAA_A-_"; select the appropriate

Zone Category of your project and insert JAl Zone Defout Settings 12 sl
o

» 7 Name and Positioning
__» [, FloorPlan
h E Zone Stamp

BCA_ZoneStamp ¥ . (m

the Zone Name.

 arial v Western ~  [#] Use Symbol Colors
M1 5.00 mm

>

Zone Polygon (Gross, Net)

.Open Zone Setting;[ (X and in the Zone o o

Show Frame

00°

<zone name>
A 3000m2

£
&
&

Stamp panel - make sure the Zone Name b_Show Zone Name

Show Zone No.

b Show Ventilation

and Measured Area are turned ON then ﬁ e ry——

click OK. Show Perimeter

b Show Ceiling Height
Show Volume

3 for Listing

»

sRe99R®

288

%'S Custom Settings

___» & Tags and Categories

£ (@ L-_AREAGFAA_A-_GFA ») Cancel oK

J

. i N .
In the Info Box, select the Construction T ;t___

= B
Method: Manual £ |and start to draw the | ac |

area boundaries of the floor GFA. Then, 3 Soroy

R

click to place the zone stamp.

|
Copyright © 2015 Building and Construction Authority. All Rights Reserved. 16
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.Double click to open the respective floor s el =
fin} B 9
plan views under the URA folder of the B =TTy =

&[] Floor Plans
i ..[g URA-_FP_ROOF
[P URA-_FP_ 10TH STOREY
-[3 URA-_FP_ 9TH STOREY =
[ URA-_FP_ 8TH STOREY
-[3 URA-_FP_ 7TH STOREY
[ URA-_FP_ 6TH STOREY

View Map in Navigator palette.

w5 URA-_FP_ 5TH STOREY
. URA-_FP_ 4TH STOREY
At the bottom of the navigator palette (if you ol
are using a standard V18 profile), click the N @E&"”"‘“’m =
g )
‘Settings’ button. In the View Settings
Boaax
dialog, click Get Current Windows Settings, v Properties
and C“Ck OK [y URA-_FP_ 2ND STOREY

I Get Cument Windows Setings ] I Selected: 1, Editable: 1

v Identification

ID: Custom Al URA- FP

Name: By Project Map v |1st STOREY

Source: . 1stSTOREY

¥ General
5 Layer Combination: URA -
@ Scale: 1:100 ¥
B Structure Display: Entire Model v
9 Pen Set: 01 3D SUBMISSION 012009 -
Model View Options: SUBMISSION -
@ Renovation Filter: 01 Existing Plan v

Note: Regsrdless of this view's scale, GDL objects will be represented sccording to
the source viewpoint's scale.

¥ 2D/3D Documents

{ Floor Plan Cut Plane Settings... J
& Dimensions: ":';D_Submission_os -
Q Zooming: Fit in window >

[¥] 1gnore zoom when opening this view

» 3D Only

|
Copyright © 2015 Building and Construction Authority. All Rights Reserved. 17
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o TiE
(- [E] Floor Plans
Double click to open the “URA- :

(- [G] Sections
(#1-[] Elevations
_LV_SUMMARY OF GROSS FLOOR | g g Doaments
AREA (GFA)_ver1” under the Schedules ;i%‘x:i:ﬁmﬁﬁmw
. ) \.-{&] Interior Elevations
folder. The GFA is auto-tabulated for you @
according to format. ~[EJURA-_LV_Worksheets

fEm e bar A s e

N

.Alternatively you can use the other tables to

suit your need. To configure the settings
click the ‘Scheme Settings...” button.

[l URA-_LV_SUMMARY OF GROSS FLOOR AREA (E-GFA) Sample

- View Map.
e % (& NEERY
[ Freeze Schedule Header
Gy g s Lo
|l URA- LV_SUI
T [Block o | Sorey |

u SUMMARY OF GROSS FLOOR AREA (GFA)_ver
URA-_LV_SUMMARY OF GROSS FLOOR AREA (GFA)_ver2
URA-_LV_SUMMARY OF GROSS FLOOR, AREA (E-GFA) Sample
LRA-_LV_DOOR LIST
URA-_LV_ WINDOW LIST

.To insert the Block No of the respective - (e %]

GFA areas defined. Open the Zone I exsiictas

L R T - R

M1 s5.00 mm

L. Ceiling Material

Al

. e
Settings » Zone Stamp » Parameters for URE- LV_SUNIVARY OF GROSS FLOOR AREA [GFA)

Lo Block No. Storey GFAm2) Usage Type
Listing » Input Block No. Z ETSTPHEY zgfsﬁﬂz CammenE
This way Block No. will auto-generated in | zone befautt settings (L2 [
the GFA Table. Fevortes.. Defeult

» =] MName and Positioning
Note: You can choose to drag and drop the 0 ;'.',’,'.’;::;.,,

tabulated GFA summary into the = -

_ _ [BcA_Zonestamp L )]
layout/sheet, or leave it in the

Schedule folder. v el - J| West=m

- [¥]use Symbol Colors

Block No 147] <zone name>
L. Input GFAvalue A 2000 m2
L. Input Non-GFA value
L.. Input Other Non-GFA value
L. User Defined 1
L. User Defined 2 H
[ 2D Representation
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For (BCA) SGFA Tabulation:

D) o@Ea |

: - Q1BCA-_GenericPerspectve
can be viewed from |- @ BCA-_3D_Frontal Axonometry
Navigator » BCA Folder » -G Detais

- LV_SUMMARY OF STATISTICAL GROSS FLOOR AREA A
[l] BCA-_LV_ SUMMARY OF OTHER AREAS NOT INCLUDED IN GFA COMPUTATION

Schedules
\ )/

. To auto-generate SGFA table; For areas
NOT counted as GFA, from the Toolbox

TJil] BCA-_LV_WINDOW LIST
SR IRA

select l ta Zone tool. In the Info Box of I

i

Description

Zone, assign the layer “A-
_AREAGFAD_A-_.NonGFA”. Select the

appropriate Zone Category and insert the

Zone Name. 0

Zone Category

E-GFA Carpark Residual Areas
E-GFA Communal Landscaped Areas

E-GFA Covered Walkways a
E-GFA Thru Block / Upp Level Linkages
E-GFA Sky Terrace ]
content of each table o Sunmoory GFA ﬁwﬁm,«pﬁm ]
before using. panel helps TR dlerenause [Factory :
- ¥ (= :
you filter the Element type: Zone W o Commercial :
and Layer that will reflect in the ,Z‘r’]"’t—"“'!‘-“"‘— GFA  Hospitality "1
biz - GFA  Education & Cultur .
SGFA table. oA A -1k
i "+, || Solid Line 3 GFAA_EXISTING Area a
contains selected parameters (or Pojsdine 2] caateem .
SGFA GFA +Non-GFA L

information) to reflect in the table
i.e. Description, GFA, Non-GFA and

Total SGFA. /
AN

Tl Zone Default Settings [k
-
(G itioning
» [, Floor Plan
. &) e
Open Zone Setting; I ®== and in the Zone " ve e
v anal || Westem v [7]use Symbol Colors
Stamp panel - make sure the Zone Name Miso
Zone Polygon (Gross, Net) o
and Measured Area are turned ON then For S el oo <aope pame>
click OK. = —
b Slvv\u\!ll-ll.on oft
DS
how 'men‘A :
b e g vignt o
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. . f ne ult Settings m
. After creating a Zone object, select the et
Detaut
object and open the Zone Settings > Zone _———rr
Stamp panel > Parameters for Listing o S
Indicate the Block No. and GFA or Non- e ' =
GFA measured value generated for the N:;“Tm Ml M Lafoe ket
selected zone. e N -
C oz 20 e
This way the Block No., GFA and SGFA will ;ﬁjx::::;:m
auto-generated in the SGFA Table. f.'.':.m':':. {
. Il._mun-nm»r ¥
Repeat steps 43-45 for all Non-GFA T
areas (zones). E i sueces: o o 0
[ Freeze Schedule Header

Note: SUMMARY OF OTHER AREAS

NOT INCLUDED IN GFA

COMPUTATION will auto-generate
the

same NonGFA values
generated from the SUMMARY of
SGFA table, provided you use the
same Layer for the Zone objects.

This makes it easy to generate the
table without doing it from start

again. /
. For areas counted as GFA, from the

Toolbox selecti [a Zone tool. In the Info
assign the “A-
_AREAGFAA_A-_.GFA”. Select  the

appropriate Zone Category of your project

Box of Zone, layer

and insert the Zone Name.

. Repeat steps 44-45 for all GFA areas

(zones).

D 1 I 10 I Zﬂl 1 0 1 4 1 50 1 e 1 70. I 80 I 20 I 100 I 11ﬂl
“1[BCA-_LV_ SUMMARY OF OTHER AREAS [
E_ NOT INCLUDED IN GFA COMPUTATION

& Description

- SIN (Zone Name) AREA(m2)

FA Header Options j_] ™ Selected: 0  Editable: O
[Freese Schedue Header
E]_n""1"“'""|""°°"1' S IRREPREEINEYY
7] BCA-_LV_ SUMMARY OF STATISTICAL GROSS FLOOR AREA (SGFA)

Block No.|  Storey Description | s (mg) | Non-GFA GFA + NonGFA

(Zone Name) m2)

(m2)
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PART VI. Annotation & Symbols

Note: The basic annotation and symbols
provided in the template only meant
to help you in creating elementary
annotations  for  your  project

submission. They are not exhaustive
list and you are free to edit/change ‘ FOR REFERENCE ONLY ‘
according to your needs and the
requirements as specified in the BIM
e-Submission Guideline. /
§ [l Object Default Settings [EA™)
== Load Other Object... 3] 7 [[Favortes... Default
. 7 ame———
s BIM Server Libraries - mQ-ntmy[g]
To place the symbol “for reference only” on the | “=&ess Rpo ] 8 @‘?
) . ) . ‘xj:é:“ﬂmmw‘wx | m:m%‘dm o.nn:' 2 [y
drawing views, double click the Object Tool = I
B s @ Home Story:
under the Toolbox. Select the T Tl R —
“Annotation_AuthorityReference” symbol m =
under the Embedded Library. Select the || BT A

‘Show on Stories &
- SYMBOL

placement at appropriate layer and click OK. B ooyt naipes

B> Enable Object’s Pens
O symbolLines
[O.9 SymbolLine Pen

.Click to place the symbol in the drawings.

Master Bedroom
A 1751'364 m2

.To place the zone stamp with indication of

ventilation type, double click the Zone Tool

under the Toolbox.
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.In the Zone Default Settings, make sure that

[l Zone Selection Settings [0 [ |
the “BCA_ZoneStamp” is available under the —— e
x ] Name and Positioning
Zone Stamp. Then insert the Zone Name, 2one oo [ Connercl D)
Zone Category and Ventilation Type etc. —— T M;:ivg;:,
Zone Level: 0 Zone Stamp Angle:
Select the placement at appropriate layer and sonrmonall o 2
click OK. e e
it Zone Stamp
= ] *: @
Note: BCA_ZoneStamp is already i e B i
part of the Embedded Library we -
found in the Library Manager of = erow ertron o ] =
“SG_BIM e-Submission s 1
Template_v18.tpl".

Click Options menu Element _
Attributes  Zone  Categories, (BT ) (o) [
select the “BCA_ZoneStamp’,

and click OK.

A\

E_ Load Other Object...

.To place the north arrow on the floor plan | =

[ Embedded Library
- (@] Linked Libraries
() ArchiCAD Library 15

views, double click the Object Tool under = O s s
[ 1.3 Windows 15

Toolbox. Click Libraries » ArchiCAD Library i

| 602 1.6 Mechanical 15
[ 1.7 2D Bements 15

18 » Object Library 18 » 1.7 2D Elements 18 O Do s
JaN

» Graphic Symbols 18 » Signs 18, then | .'_=.
select North Symbol 18.

.Under the Symbol Styles section, select the

“Scale with plan (Model Size), and “Follow v == o et O )
v (@)@
Project North”. Then place it at appropriate | = é; 4 —
layer and click OK. W E?‘Hm
& B ] Lo ) T
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PART VII: A&A Works/ Re-submission (URA)/ Amendments

|
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.By default, all elements/objects available inside [reas,.

the template are set as Existing (in ArchiCAD

term) or Proposed Element (in magenta, P SEECTED ELEMERT
based on CP83 Part 5). To change or assign

new renovation status, open the viewpoint in

the Project Map of Navigator Palette, select A ) Goons
the element/object you want to change status, ?
right click and select Object Selection Settings Wvesesior s - s
Selecied: 1 Eaitable: 1
(or Ctrl + T). o
W =B
) ) e
Under Tags and Categories of the Object = ML L& [ o
Selection Settings, go to Renovation and B —
» A Model
select renovation status (Existing, To Be

Position Interior

Demolished or New) accordingly.
Element Classification ArchiCAD Type
.Click OK. T e e 5

.Use Renovation Palette to change/ assign o — Y e | (]|

renovation status for multiple elements at one

time by selecting elements first then click on Renovation E

Default elements:

the renovation icon representing the status
p g = I
you need under “Default elements:”

REH{ Existing Status ]
01 Existing Flan -

[rvores.. ] ®  Aoply Favorttes et
* @ Goometryand Positon Save Current Settings as Favorite
Favorite Names:
Wl Tp Wall - Bent Shell
1. 2ND STOREY (Home + 1) Wall - Composite
7 Wall - Fundation cp 83
Wall - Parapet cp 83 4
= 0 Wall - Partition cp 83 |
Wall - Structural cp 83
o |
\ Home Story: )
\ 0. 1ST STOREY (Current) Caioal
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.For additional filter options, go to Document
menu » Set Renovation Filter » Renovation
Filter Options under “Filter Settings” (Show,
“Additional Filter

Hide or Override) and

Options for.”

.To change override styles for each filter
settings, click “Renovation Override Styles...”
Choose which renovation filter to override
(Existing  Element, Elements To Be

Demolished, or New Elements); Check box to

change 2D representation and material on 3D.

.Click OK.

Note: The
based on
codes for

Renovation Filter colour is
the three CP83 colour
A&A |/ Re-submission

(URA)/ Amendments submission, as
specified in the Architectural BIM e-
Submission Guideline and is already

in the "SG_BIM
Template_v18.tpl".

e-Submission

Click Document menu » Set
renovation Filter to see Renovation

Filter Options.

. Click to open the respective floor plan views
under the URA folder of the View Map in
palette. At the bottom of the

A

Navigator
navigator palette. Click the Settings button. In
the View Settings dialog, under General,
select Renovation Filter to represent its A&A

Work status, and click OK.

Document menu »

Set renovation Filter » Renovation Filter
Options.

NS

Override Styles for: 5, Elements to be Demoished -
[¥]Line Type E“:’e"‘_____________'l
[] LineMarker fText Color B =
Framee
[]Fil Foreground Color 2 [
[EFil Background Color

(] Material

[ Paint-0s »|

ID: Custom v URA-FP_
Name:  ByProjectMsp v |iSTSTOREY
Source: . 1STSTOREY
~ General
S Layer Combination: URA hd
@ Scale: 1:100 -
B Structure Display: Entire Model -
@ Pen Set: 3D SUBMISSION 012009 -
B Model View Options: SUBMISSION A
| A Rencvation Filter: A-A Works - |

Note: Regardless of this view's scale, GDL objects will be represented according to
the source viewpoint's scale.

» 2D/3D Documents

» 3D Only

(o | [ox ]
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PART VlIl: Endorsement & Data Information

. Double click to open the sheets from

Layout Books of the Navigator palette.
Click on the sheet on the drawing area and
change the type according to the regulatory

authority you are submitting to.

.Under the Properties palette at the bottom
of the Navigator, select the appropriate
endorsement statement that matches your
submission (refer to Appendix B of BIM e-

Submission Guideline).

Note: Each sheet could only contain 1
endorsement statement. If you have
more than 1 endorsement statement
to submit, create more layouts in the

Layout Book of Navigator Palette.
However, remember to rename the
layout/view according to the naming
convention as specified in the
Architectural BIM  e-Submission

Guideline.
AN\ 4/

. To insert basic project information and
QP’s name in the title block and the
endorsement statements without repetition,
right click on the Layout tab and select
Project Info.

.In the Project Info dialog, insert all the

necessary information of your project, and
click OK.

Tree by subset ' >

v 3 #Insert Project Name
[dA.01 URA-_LV_ARCHITECT'S DECLARATION
I [2A.02 BCA-_LV_ARCHITECT'S DECLARATION I
[8A.03 FSSD-_LV_ARCHITECT'S DECLARATION
[8A.04 CBPD-_LV_ARCHITECT'S DECLARATION
v i Masters

B8 BCA-BP with Acceptable Solutions

@B BCA-BP with Alt Sols_Sole

B8 BCA-BP with Alt Sols_Joint

BB BCA-A8A

[ BCA-ST with Acceptable Sols

B8 BCA-ST with Alt Sols

B BCA-CD_QP

BB URA- Owner Consent, DIP & RLP

BB URA-Subdivision Appin

B8 URA-Strata Subdivision Apptn

BB URA-Conservation_Architect

B8 URA-Conservation_Engineer

BB FSSD-FSW w Prstv Prvsn FC_BP

BB FSSD-FSW w Prstv Prvsn FC_FP&AC

BB FSSD-FSW w Alt Sols_BP_Option1

B8 FSSD-FSW w Alt Sols_BP_Option2

BB FSSD-FSW w Alt Sols_FP_Option1

BB FSSD-FSW w Alt Sols_FP_Option2

B FSSD-AGA

[ CBPD/PUB-DIP

BB Other Technical Departments

5 [ [
'v Properties
@ A.02 BCA-_LV_ARCHITECT'S DECLARATION
BCA-BP with Acceptable Solutions | >
841/594
Il
Settings...
Navigator - Layout Book. X
s i e
| Tree by subset »

CH New Layout
lﬁ Create New Subset

BCA-Bl

with Alt Sols_Sole
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Note: This is a one-time setting ONLY and the

. - : : [ E4 Project Info X (G
same information will appear in all the — o =
layouts/sheets created. L G [prser Gient Name o) —— |

2 Project Name #Insert Project Name | Delete |
3 Project Number #Insert Project Number
4 Company #Insert Company Name
5 Street —
. : = =
7 State/Country —
8 Postal Code -
In some of the endorsement statements, o e R
. . 10 CAD Technician # Insert DraftPerson
AutoText was not created. You can fill in 11 Project Status
12 Date of Issue
the blanks using the Text tool from o
15 Structural Engineer ----
Toolbox. 16 Accredited Checker —
17 Surveyor #Insert Surveyor Name
18 Architect's Regist... --—
19 Architect's Address ----
20 Mechanical Engin... ——
21 Fire Safety Engin... -
- Save
[ ]

\ /

. Besides endorsement statements and
titleblocks, the sheet could also contain
data information like schedules. Drag and
drop your GFA summary schedules etc.
(as shown in Section V) into the sheet.
Alternatively, you can retain your
schedules in the floor plans, or in the
Schedule folder.

PART IX: Export/Publish to PDF
. Refer the relevant GRAPHISOFT

Helpcenter article for step-by-step guide to

export/ publish to PDF for regulatory

submission.

|
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